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Introduction 
Thank you for choosing BackupBuddyVFS!  
BackupBuddyVFS is the latest in backup technology from the makers of BackupBuddy®, the award-winning 
and industry standard backup solution for Palm Powered™ handheld devices.  BackupBuddyVFS is designed 
to work with organizers that support the Virtual File System (“VFS”), such as the Palm m500 and m505, the 
Sony Clié and HandEra 330.   

With BackupBuddyVFS installed on your organizer, you can effortlessly backup your organizer’s critical files to 
the Sony Clié’s Memory Stick or to Secure Digital or MultiMedia expansion cards for Palm organizers 
(“expansion cards”).  In the event of a loss of data, you can then use BackupBuddyVFS to restore your 
organizer’s data from an expansion card.  As a result, you no longer need to wait until you have access to your 
Hotsync cradle or a modem to backup or restore your data.   

BackupBuddyVFS provides you with peace of mind when you are on the road - effortless mobile backups and 
restores from the company you trust! 

Note regarding BackupBuddyVFS:Free 

BackupBuddyVFS:Free is the free, limited version of BackupBuddyVFS.  BackupBuddyVFS:Free 
enables you to backup all or your organizer’s files to and restore all of your backup data from 
your organizer’s expansion card.  With the free version, you are not able to select individual files 
for backup or restore, schedule automatic backups or perform the other advanced features 
described in this manual. 

Thanks again for using BackupBuddyVFS. 

The Blue Nomad Team 

 
 Blue Nomad, LLC 

4 Hyde Street 
Redwood City, CA  94062 

www.bluenomad.com 

http://www.bluenomad.com/
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Features and Requirements 

Overview of Features 
The following is a general overview of the features of BackupBuddyVFS: 

•  Ability to backup to and restore files from an expansion card at any time 

•  Ability to easily customize what is backed up (or restored) 

•  Ability to backup your organizer every time you power off your organizer 

•  Ability to set a time every day when BackupBuddyVFS will backup your organizer 

•  Restoring an organizer in the event of catastrophic data loss is as simple as launching 
BackupBuddyVFS on your expansion card and tapping the Restore button 

•  Easy to install: download and install like you would any other Palm application, tap the Backup icon 
and rest assured that the organizer's data is secure 

•  Optionally backs up files deleted from the organizer to the expansion card so that such files can be 
easily located and reinstalled if needed 

•  Ability to beam or delete files on your organizer from within BackupBuddyVFS 

•  Jog dial support! 

•  Streamlined interface displays the status of backups and restores while they are in progress 

Requirements 
BackupBuddyVFS requires: Palm 500 series device or HandEra 330 with an expansion card or Sony Clié with 
Memory Stick 

Chapter
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Getting Started 
This Chapter covers installation and the basics to get you started quickly! 

Installing BackupBuddyVFS 
To install BackupBuddyVFS, follow these 3 simple steps:  

Step 1: Download.  Download BackupBuddyVFS and save it to your computer. 

Step 2: Install to Organizer.  Use the Palm desktop install tool (or InstallBuddy ) to install 
BackupBuddyVFS to your organizer, like you would any other Palm application.  Once installed 
on your organizer, you will see the Backup application icon shown in the middle of the first row 
below.   

 

Step 3: Install to Expansion Card.  Simply launch the Backup program and you will be 
prompted to install BackupBuddyVFS onto the expansion card.  If you don’t install 
BackupBuddyVFS onto the expansion card, you will be prompted to do so each time you launch 
the application.  It is highly recommended that you install BackupBuddyVFS onto your 
expansion card.  In the event BackupBuddyVFS is deleted from your organizer (as a result of 
battery loss or a hard reset, a copy of BackupBuddyVFS on your expansion card can facilitate the 
restoration of the backup data on such card.  Please see below for more information on restoring. 

Note regarding upgrading from the free, trial or older version 

Chapter



 

 3333

If you are upgrading from the free or trial version of BackupBuddyVFS, you can 
simply install the full version over the free or trial version. When you launch the full 
version on your organizer, you will be prompted to install the full version onto your 
expansion card. There is no need to remove the other version beforehand. Please 
note:  It is highly recommended that prior to upgrading from an older version of 
BackupBuddyVFS to a newer version, you delete all backup files on your expansion 
card. 

BackupBuddyVFS Basics 
Once installed, BackupBuddyVFS is a breeze to use.  This section describes the basic backup and 
restore functions that are available in the regular and free version of BackupBuddyVFS.  The 
advanced features are covered in Chapter 3. 

BackupBuddyVFS Basic Screen 
When you launch the application you will see the basic BackupBuddyVFS screen shown below.  
Please note that the basic screen for BackupBuddyVFS:Free does not have a Preferences… 
button.   

 

The basic screen provides you with the following basic options: 

Backup.  Tapping on the Backup icon will initiate a backup of all of the files on your organizer 
to your expansion card and will launch a progress meter such as the one below.  The progress 
meter tells you where in the backup process you are.   

 



 

 4444

Only files that have been modified since your last backup will be backed up.  Please note that 
users of BackupBuddyVFS have the option of customizing backups by selecting which files to 
backup.  Please see Chapter 3 for a description of the advanced features of BackupBuddyVFS. 

Restore....  Similarly, tapping on the Restore icon will initiate restoration of all of the backup files on 
your expansion card to your organizer.          

  

Once you have tapped on the Restore button, a Restore progress meter such as the one above 
will appear.  The progress meter tells you where in the restoration process you are. 

If your organizer has suffered catastrophic data loss and you have installed BackupBuddyVFS on 
your organizer’s expansion card, you may recover all your backup data from the expansion card 
by doing the following: 

•  Launch BackupBuddyVFS on your expansion card. To launch BackupBuddyVFS 
on your expansion card, simply launch it like you would any other application stored on 
the expansion card. (For example, on Palm devices, turn on your organizer, use the pull 
down menu in the upper right hand corner of your organizer to display all applications on 
your expansion card, and then launch BackupBuddyVFS from the expansion card).   

•  Tap on the Restore button. 

Please note that users of BackupBuddyVFS have the option of customizing restorations by 
selecting which backup files to restore.  Please see Chapter 3 for a description of the advanced 
features of BackupBuddyVFS. 

Preferences.  Tapping on this button will open the following basic preferences dialog box. 
Alternatively, from the basic BackupBuddyVFS screen, tap on the Menu icon and Options -> 
Preferences… to open this dialog box. 

 

The basic Preferences dialog box for BackupBuddyVFS has the following Backup 
schedule features: 
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When I turn my organizer off.  If this option is enabled, the files that you have selected 
for backup will be backed up when you turn your organizer off.  Please note that enabling 
this option will not initiate a backup when your organizer goes to sleep. 

Every day at...  If you enable this option, the files you have selected for backup will be 
backed up at a certain time every day.     

Basic Screen Menus 
From the Basic screen you may also access the Options menu shown below.  .  Please note that 
BackupBuddyVFS:Free does not support the Preferences… or Advanced features.   

 

Backup.  As described in more detail above, selecting Backup will initiate a backup of all of the 
files on your organizer 

Restore.  As described in more detail above, selecting Restore will initiate restoration of all of the 
backup files on your expansion card to your organizer.  

Delete backup files. Use this feature to delete backup files placed on the expansion card by 
BackupBuddyVFS. 

Preferences.  Select Preferences… to schedule your backups for a certain time each day or to 
always occur when you power off your organizer. Please see the description of the basic 
preferences of BackupBuddyVFS in the section above for more information. 

Upgrade/Register.  Select this option for information on registering BackupBuddyVFS.  Please 
note that this menu item is only available in the free or trial version, respectively.  

Advanced.  Select Advanced to access advanced features, such as the ability to customize your 
backups and restores by selecting files to backup or restore.  Please see Chapter 3 for a description 
of the advanced features of BackupBuddyVFS. 

About BackupBuddyVFS.  Select this option to see what version of BackupBuddyVFS you are 
running. 
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Advanced Features 
This Chapter covers advanced backups, advanced restores and the other advanced features 
available with BackupBuddyVFS. To access the advanced screen shown below and these features, 
simply launch BackupBuddyVFS on your organizer, open the Options menu and select 
Advanced.  Subsequent launches of BackupBuddyVFS will take you directly to the advanced 
screen.  If you want to view the basic screen, open the Options menu and select Basic. 

 

Advanced Backups. 
BackupBuddyVFS lets you select which files to backup.   To view the advanced backup screen 
shown above, launch BackupBuddyVFS and from the basic screen simply open the Options 
menu and select Advanced.  The advanced backup screen will list all files that are on your 
organizer. 

Once you have chosen which files to backup, a simple tap of the Backup button (from the 
advanced screen) or tap of the Backup icon (from the basic screen) will backup those files. The 
advanced backup features are described below. 

Selecting Files for Backup.  .  .  .      
BackupBuddyVFS will backup all files that have been selected for backup.  You can select files for 
backup by manually checking off the files (i.e., by selecting the file name) or by using the File 
menu -> Select All feature.  In the event you find that you have selected too many files or want to 
wipe the slate clean, simply use the Select None option from the File menu.  Alternatively, to 
unselect or uncheck any file, simply select it again. Lastly, if you have a jog dial, you may use the 

Chapter
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dial to scroll up and down through the files.  Please note that BackupBuddyVFS will only backup 
files that have been modified since your last backup.   

Backup.            
Once you have decided which files to backup, simply tap on the Backup button in the lower left 
hand corner of your organizer’s screen.  This will launch a progress meter such as the one below.  
The progress meter tells you where in the backup process you are.   

 

 

Size of File and Size of All Files to be Backed Up.   
BackupBuddyVFS lists the size of each file and the size of all files to be backed up.  To the right 
of each file name is the file’s size.  In addition, the number in the lower right hand corner of the 
screen indicates the size of all files to be backed up.   

Advanced Restores 
BackupBuddyVFS’s advanced restore function is virtually identical to the advanced backup 
function.   To view the advanced restore screen, launch BackupBuddyVFS and from the basic 
screen simply open the Options menu, select Advanced and then use the pull down menu in the 
upper right hand corner to switch the advanced screen to Restore mode. If you are already in the 
advanced screen, use the pull down menu in the upper right hand corner to toggle between the 
advanced backup and advanced restore screen. The advanced restore screen will list all backup 
files that are on your organizer’s expansion card. 

You may restore one or more or all of your backed up files to your organizer.  This section covers 
how to restore data in the event of total data loss and how to restore individual files.   

Selecting Files for Restoration.  .  .  .      
BackupBuddyVFS will restore all files that have been selected for restoration.  You can select files 
for restoration by manually checking off the files (i.e., by selecting the file name) or by using the 
File menu -> Select All feature.  In the event you find that you have selected too many files or 
want to wipe the slate clean, simply use the Select None option from the File menu.  Alternatively, 
to unselect or uncheck any file, simply select it again. Lastly, if you have a jog dial, you may use the 
dial to scroll up and down through the files.   
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Size of File and Size of All Files to be Restored.   
BackupBuddyVFS lists the size of each file and the size of all files to be restored.  To the right of 
each file name is the file’s size.  In addition, the number in the lower right hand corner of the 
screen indicates the size of all files to be restored.  

Restoring Data in the Event of Total Data Loss.   
If your organizer has suffered catastrophic data loss and you have installed BackupBuddyVFS on 
your organizer’s expansion card, you may recover data that you have selected for restoration from 
the card by doing the following: 

•  Launch BackupBuddyVFS on your expansion card. To launch BackupBuddyVFS 
on your expansion card, simply launch it like you would any other application stored on 
the expansion card. (For example, on Palm devices, turn on your organizer, use the pull 
down menu in the upper right hand corner of your organizer to display all applications on 
your expansion card, then launch BackupBuddyVFS from the expansion card).   

•  Tap the Restore button. 

Restoring Individual Files.  
To restore an individual file or files from your expansion card to your organizer, simply do the 
following: 

•  Launch BackupBuddyVFS on your organizer 

•  Open the Options menu and select Advanced  

•  Use the pull down menu in the upper right hand corner and select Restore 

•  Select the file(s) you wish to restore 

•  Tap on the Restore button 

           

Once you have selected the file(s) that you want to restore and have tapped on the Restore 
button, a Restore progress meter such as the one above will appear.   
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Advanced Screen Menus 
This section describes the features that are accessible from the File and Options menus of the 
advanced BackupBuddyVFS screen. 

Advanced Screen File Menu 

 

Select All.  This menu option lets you select all files for backup or restore. 

Select None.  This menu option lets you deselect all files for backup or restore. 

Delete… This menu option lets you delete any selected file.  If you are in the advanced backup 
screen, the file will be deleted from your organizer.  If you are in the advanced restore screen and 
select this option, the file will be deleted from your expansion card. 

Beam. This menu option lets you beam selected files.  If you are in the advanced backup screen, 
the file will be beamed from your organizer.  Please note that this feature will not work on beam 
locked files. 

Remove Orphans.  This menu option lets you delete backup copies of files that have been 
deleted on your organizer (“orphaned files”). 

Advanced Screen Options Menu 
 

 

Preferences… Selecting this menu option will open the advanced preferences dialog box.  

The advanced Preferences dialog box for BackupBuddyVFS has the following options: 

Keep Orphaned Files. If you have enabled the Keep orphaned files option, files that 
have been deleted on the organizer will automatically be backed up to the expansion card 
with BackupBuddyVFS.  This is a handy option for people who may have many large 
files on their organizers that they do not need to use every day.  They can simply delete 
them, back them up to the expansion card and restore them from the card, if needed.   

When I turn my organizer off.  If this option is enabled, your files will be backed up 
when you turn your organizer off.  In addition, if you check the box for “use my 
backup set,” only the files that you have selected for backup will be backed up when you 
turn your organizer off.  Please note that enabling this option will not initiate a backup 
when your organizer goes to sleep. 
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Every day at...  If you enable this option, your files will be backed up at a certain time 
every day.   In addition, if you check the box for “use my backup set,” only the files that 
you have selected for backup will be backed up at the selected time.   

Basic.  Selecting this menu option will enable you to get back to the basic BackupBuddyVFS 
screen. 

About BackupBuddyVFS.  Select this option to see what version of BackupBuddyVFS you are 
running. 

BackupBuddyVFS Limitations 
The BackupBuddyVFS currently has the following limitation: 

It cannot backup or restore data in flash memory, on HandSpring Visor Springboard 
modules or files marked “read-only” on the organizer. 

Removing BackupBuddyVFS 
You can remove the BackupBuddyVFS application from your organizer and your 
expansion card like you would any other application.  The below describes how to 
remove the program from a Palm organizer.  If you are using a Sony Clie, please 
consult the documentation that came with your device. 

Recommendation:  Delete Backup Files Prior to Removing 
BackupBuddyVFS 

Before you remove BackupBuddyVFS (or BackupBuddyVFS:Free), from your 
organizer, we recommend that you delete any backup files placed on your expansion 
card by our program.  These files can only be deleted by BackupBuddyVFS.  To 
delete these files, simply launch BackupBuddyVFS in basic mode, open the Options 
menu and select Delete backup files.  

To remove BackupBuddyVFS from your Palm organizer: 

Step 1:  Tap on the Applications icon and then tap on the Menu icon  

Step 2:  Select the App menu and then tap on Delete… 

Step 3:  Select the Backup program and tap the Delete… button. 
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To remove from the expansion card: 

Step 1: Follow steps 1 and 2 above   

Step 2: On a Palm device, use the Delete From: pull down menu to switch the “Delete From: 
Handheld” to “Delete From: Card.”  For all other devices, please consult your device’s user 
manual for assistance. 

Step 3:  Select the Backup program and tap the Delete… button. 
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Registering and Technical 
Support 

Registering 
If you're using the free or trial version of BackupBuddyVFS and would like to register (i.e., 
purchase) a licensed copy, please visit the purchase center at Blue Nomad, LLC’s website: 
http://www.bluenomad.com, or write to sales@bluenomad.com for ordering information.   

Currently, BackupBuddyVFS may be purchased online, by mail or fax or by sending in a purchase 
order.  If you purchase online from our secure web-server, you will immediately be able to 
download a registered copy of the software.  For instructions on installing the full version, please 
see Chapter 2 of this manual.   

Please note that Blue Nomad, LLC’s license policy is that one license entitles a user to backup one 
organizer.  

Site Licenses and Special Discounts 
In addition, volume discounts and site licenses are available. Please contact our sales department 
(mailto:sales@bluenomad.com) for details.  

Updates & Email Address Changes 
If you are a registered user and your email address changes, please let us know so that we can 
continue to email you updates to our software.  When sending us an email address change 
notification, please include your full name, old email address and new email address to expedite.  
Or, if you think that you may have missed an update, please let us know by sending us your full 
name and email address. Please send all such requests to upgrades@bluenomad.com. 
  

   

 

Chapter
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Technical Support 
If you have a question that's not answered in this document, please visit the support center at 
www.bluenomad.com to review our frequently asked questions (FAQs) section. We will 
constantly be updating our FAQs and our website to better serve you. 

If you don’t find your question in the FAQs, please email your technical support question to: 
support@bluenomad.com. We make every effort to answer email inquiries within one business 
day (California time).  

What to include with your support inquiry? 
Please include the following with your question: 

1. Information on your organizer.   Please provide us with information on what 
organizer, Palm OS version and type of expansion card you are using.   

2. Please provide a detailed description of the problem.    For example, if you are 
experiencing an error, please give us the exact error and the scenario when the error 
occurred.   

Thanks for your cooperation! 

Email Address Changes 
If you are a registered user and your email address changes, please let us know so that we can 
continue to send you updates to our software.  When sending us email address change 
notifications, please include your full name, old email address and new address to expedite.  Please 
send all such requests to upgrades@bluenomad.com. 

Alternatively, if you'd like to write to technical support via snail-mail, correspondence should be 
addressed to:  
 
Blue Nomad, LLC 
Attn:  Technical Support 
4 Hyde Street  
Redwood City, CA  94062 

BackupBuddy is a registered trademark of Alexander S. Hinds, M.D. BackupBuddyVFS, BackupBuddyVFS:Free and InstallBuddy 
are trademarks of Blue Nomad, LLC. 

Palm Computing is a registered trademark of Palm, Inc. or its subsidiaries.  Handspring, Visor, and Springboard are trademarks of 
Handspring, Inc. All other companies and products listed herein are trademarks or registered trademarks of their respective holders. 
 

 

 

http://www.bluenomad.com/
mailto:support@bluenomad.com

	Introduction
	Overview of Features
	Requirements
	Installing BackupBuddyVFS
	BackupBuddyVFS Basics
	BackupBuddyVFS Basic Screen
	Basic Screen Menus

	Advanced Backups.
	Selecting Files for Backup.
	Backup.
	Size of File and Size of All Files to be Backed Up.

	Advanced Restores
	Selecting Files for Restoration.
	Size of File and Size of All Files to be Restored.
	Restoring Data in the Event of Total Data Loss.
	Restoring Individual Files.

	Advanced Screen Menus
	Advanced Screen File Menu
	Advanced Screen Options Menu

	BackupBuddyVFS Limitations
	Removing BackupBuddyVFS
	Registering
	Site Licenses and Special Discounts
	Updates & Email Address Changes

	Technical Support
	What to include with your support inquiry?
	Email Address Changes


